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Presenter Notes
Presentation Notes
CHECK THE NOTES SECTION OF THIS POWERPOINT FOR HELPFUL HOW-TO’S FOR COLLECTING DATA ON VARIOUS SECTIONS
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January February March April May June July August September October November December

7457 7511 7585 7653 7685 7743 7792 7898 7974 8058 8132 8217
204 176 177 182 191 185 204 210 214 316 297 295
1774 1825 1526 1577 1614 1640 1636 1826 1828 1898 1858 1861

Number of Users per Month

January February March April May June July August September October November December

9609 9668 9735 9775 9818 9859 9950 10026 10014 10081 10130 10178
241 211 241 216 236 216 213 255 248 243 239 233
1417 1460 1430 1358 1358 1322 1363 1465 1368 1410 1391 1312

2023 Users

2019 Users

Chart Legend

Total Users

Avg. Daily Active Users

Monthly Active Users

2022 Users

January February March April May June July August September October November December

10216 10266 10341 10383 10442 10487 10532 10614 10669 10730 10789 10825
241 242 259 233 259 256 247 282 253 264 252 234
1418 1379 1382 1310 1320 1331 1377 1426 1295 1370 1357 1245

2021 Users

2020 Users
January February March April May June July August September October November December

8272 8327 8374 8410 8454 8485 8568 8659 8704 8755 8800 8884
296 272 282 258 235 253 262 237 238 256 235 263
1844 1909 1713 1573 1596 1638 1676 1671 1595 1639 1467 1640

January February March April May June July August September October November December

8944 9010 9058 9101 9132 9189 9241 9296 9387 9455 9503 9564
255 238 242 239 236 256 244 251 224 231 229 242
1556 1597 1527 1486 1461 1586 1531 1444 1442 1466 1502 1422

Presenter Notes
Presentation Notes
Login to PMP AWARxE > scroll down on the dashboard to the last chart titled Users > update the numbers for each month

We Switched the order of reports and placed the most recent at the top. If you notice the number of Users continues to go up and the number of monthly users are going down. I contribute this to the Gateway or integrated users being required to have an active PDMP account and accessing the information from an integrated platform in their workflow instead of the PMP AWARxE login.



All Reportable Substances Dispensed/Year 
in ND or to ND Residents
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*Gabapentin reporting started on August 1st, 2017; 2018 was the first full year of gabapentin collection.
**Veterans Affairs facilities started to report data in October 2015

Presenter Notes
Presentation Notes
Reports.analytics.bamboohealth.com

Explore > Appriss Provided [editable] > PDMP Analytics > Dispensations – Over Time > Prescriptions > Change the Year to what year you are updating > Make sure that everything else is set to (All), 
Add up the quarters you’re updating for this quarter and right click on the chart above, choose Edit Data to update the column header and content.





MEDICAL DOCTORS ACTIVE 
ACCOUNTS
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Presenter Notes
Presentation Notes
Reports.analytics.bamboohealth.com

Explore tab > Appriss Provided [Editable] > PDMP – Registration and Usage > PDMP Registered Users > Year (All); Month (All); Registration status (Approved); Active User? (True); User Role Category (Pharmacist), You’ll need to recategorize some of the User Roles into the correct category, for example the Pharmacist with Prescriptive Authority and Out of State Pharmacist should go under Pharmacist category, State Medicaid Program, Child Protective Service and Workers Compensation should go under Other (Ask Kathy) > Add up the values for the Prescriber descriptions that are bolded above > Edit the chart to update the column header and content

MD, DO, DPM, and OD includes dispensing physician, IHS Prescriber, Medical Intern w/Prescriptive Authority, Medical Resident, Military Prescriber, Optometrist, Out of State Prescriber, Physician, Podiatrist, Prescriber w/out DEA, VA Prescriber and Medical Examiner/Coroner

These are the active users by quarter, all of which have increased










PHARMACISTS ACTIVE ACCOUNTS
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Presenter Notes
Presentation Notes
Reports.analytics.bamboohealth.com

Explore tab > Appriss Provided [Editable] > PDMP – Registration and Usage > PDMP Registered Users > Year (All); Month (All); Registration status (Approved); Active User? (True); User Role Category (Pharmacist), You’ll need to recategorize some of the User Roles into the correct category, for example the Out of State Prescriber, etc. (Ask Kathy) > Add up the values for the Prescriber descriptions that are bolded above > Edit the chart to update the column header and content

R.Ph. And PharmD includes: IHS Dispenser, PIC, VA Dispenser

**Added together Pharmacist. PIC, IHS Dispenser, and VA Dispenser



ADVANCED PRACTICE NURSES 
ACTIVE ACCOUNTS
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Presenter Notes
Presentation Notes
Reports.analytics.bamboohealth.com

Explore tab > Appriss Provided [Editable] > PDMP – Registration and Usage > PDMP Registered Users > Year (All); Month (All); Registration status (Approved); Active User? (True); User Role Category (Pharmacist), You’ll need to recategorize some of the User Roles into the correct category, for example the Out of State Prescriber, Workforce Safety and Insurance, etc. (Ask Kathy) > Add up the values for the Prescriber descriptions that are bolded above > Edit the chart to update the column header and content

Advanced Practice Nurses include: Nurse Practitioner / Clinical Nurse Specialist and Midwife with Prescriptive Authority



PHYSICIAN ASSISTANTS AND 
DENTISTS ACTIVE ACCOUNTS
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Presenter Notes
Presentation Notes
Reports.analytics.bamboohealth.com

Explore tab > Appriss Provided [Editable] > PDMP – Registration and Usage > PDMP Registered Users > Year (All); Month (All); Registration status (Approved); Active User? (True); User Role Category (Pharmacist), You’ll need to recategorize some of the User Roles into the correct category, for example the Out of State Prescriber, Workforce Safety and Insurance, etc. (Ask Kathy) > Add up the values for the Prescriber descriptions that are bolded above > Edit the chart to update the column header and content

Cause for increase: VA Prescribers Registering for direct access into VA system.




PHARMACY & PRESCRIBER 
DELEGATES ACTIVE ACCOUNTS
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Presenter Notes
Presentation Notes
Reports.analytics.bamboohealth.com

Explore tab > Appriss Provided [Editable] > PDMP – Registration and Usage > PDMP Registered Users > Year (All); Month (All); Registration status (Approved); Active User? (True); User Role Category (Pharmacist), You’ll need to recategorize some of the User Roles into the correct category, for example the Out of State Prescriber, Workforce Safety and Insurance, etc. (Ask Kathy) > Add up the values for the Prescriber descriptions that are bolded above > Edit the chart to update the column header and content

Pharmacy Delegates include: Pharmacy technicians, Pharmacy technicians-in-training, Delegates for pharmacists (licensed and unlicensed)



LICENSED ADDICTION COUNSELORS 
ACTIVE ACCOUNTS
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Presenter Notes
Presentation Notes
Explore tab > Appriss Provided [Editable] > PDMP – Registration and Usage > PDMP Registered Users > Year (All); Month (All); Registration status (Approved); Active User? (True); User Role Category (Pharmacist), You’ll need to recategorize some of the User Roles into the correct category, for example the Out of State Prescriber, Workforce Safety and Insurance, etc. (Ask Kathy) > Add up the values for the Prescriber descriptions that are bolded above > Edit the chart to update the column header and content

Switched from all accounts to active accounts on Q2 2019



LAW ENFORCEMENT ACTIVE 
ACCOUNTS
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Presenter Notes
Presentation Notes
Explore tab > Appriss Provided [Editable] > PDMP – Registration and Usage > PDMP Registered Users > Year (All); Month (All); Registration status (Approved); Active User? (True); User Role Category (Pharmacist), You’ll need to recategorize some of the User Roles into the correct category, for example the Out of State Prescriber, Workforce Safety and Insurance, etc. (Ask Kathy) > Add up the values for the Prescriber descriptions that are bolded above > Edit the chart to update the column header and content

Switched from all accounts to active accounts on Q2 2019

**Total amount in investigator category 



Doctors - Authorization vs. Utilization

2022 Q2 2022 Q3 2022 Q4 2023 Q1 2023 Q2 2023 Q3 2023 Q4
ND DEA Registered Doctors 5357 5452 5522 5583 5636 5735 5802
ND Doctors who authorized prescriptions 4679 4787 4868 4940 5003 5109 5109
ND Doctors also registered with ND PDMP 2387 2431 2460 2478 2492 2518 2667
ND Doctor/their appointed delegate who accessed the

system on their behalf (counts as 1) 2345 2388 2418 2433 2445 2466 2525

5357 5452 5522 5583 5636 5735 5802

4679 4787 4868 4940 5003 5109 5109
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Presenter Notes
Presentation Notes
This data comes from the quarterly reports Appriss Provides, on the ND Prescriber Utilization tab

Can also find using search bar and typing “Prescriber Utilization”

ND DEA Registered Doctors = # DEA Registrants with ND address
ND Doctors who authorized prescriptions = # DEA registrants in ND that authorized prescriptions
ND Doctors also registered with ND PDMP = # DEA registrants in ND also registered with ND PDMP
ND Doctor/their appointed delegate who accessed the system on their behalf = # of ND prescribers or their appointed delegate who accessed the system on their behalf 


The orange bars represent the # of ND doctors registered with DEA, the reddish bars are the number of those ND DEA registrants who also authorized a prescription, pink-brown shows the # who have a PMP account, and tan are the # who looked at a PMP report or had their delegate look on their behalf.



Other Practitioners - Authorization vs. Utilization

2022 Q2 2022 Q3 2022 Q4 2023 Q1 2023 Q2 2023 Q3 2023 Q4
ND DEA Registered Other Practitioners 2172 2236 2289 2330 2367 2431 2470
ND Authorized Prescriptions 1998 2069 2125 2468 2209 2273 2273
ND Registered with ND PDMP 1325 1366 1399 1423 1440 1461 1520
ND Practitioner/their Appointed Delegate who Accessed

the System on their behalf (counts as 1) 1338 1376 1406 1430 1446 1464 1465
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Presenter Notes
Presentation Notes
This table and chart show the Other Practitioners registered in ND

DEA Registered = # DEA Registrants with ND address
Authorized prescriptions = # DEA registrants in ND that authorized prescriptions
Registered with ND PDMP = # DEA registrants in ND also registered with ND PDMP
Practitioner/their appointed delegate who accessed the system on their behalf = # of ND prescribers or their appointed delegate who accessed the system on their behalf 

*Values for the category of “Mid-levels” – Madison Nelson




ND Gateway Monthly Requests
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Presenter Notes
Presentation Notes
Explore > Appriss Provided [Interact Only] > Gateway Details > Gateway Drilldown > Change the Year and Month for a monthly request total….you can collect the next slides totals at the same time for the NDHIE.


Majority of requests are coming from Sanford Health almost 700 K




ND Health Information Network Requests
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Presenter Notes
Presentation Notes
Explore > Appriss Provided [Interact Only] > Gateway Details > Gateway Drilldown > Select Licensee NDHIE > Go to Request Type and select PatientSearch > Select the month, and the total requests is under the Appriss Health logo

Top Requesting Direct Access Accounts: 




Prescriptions Dispensed by Class
2020
Q4

2021
Q1

2021
Q2

2021 
Q3

2021 
Q4

2022 
Q1

2022 
Q2

2022 
Q3

2022 
Q4

2023 
Q1

2023 
Q2

2023 
Q3

2023 
Q4

Anesthetic 408 356 351 339 300 271 283 356 290 278 260 250 228

Cannabinoid 144 129 171 184 133 139 190 129 153 126 162 157 175

Narcotic/
Opioids

114,039 108,591 113,094 111,760 116,319 111,085 110,425 109,155 115,735 114,039 110,992 106,994 112,600

Other 47,607 45,555 47,138 47,397 47,924 45,938 40,445 46,033 38,230 38,095 39,245 38,585 39,942

Sedative 93,173 89,719 89,719 90,765 90,929 89,194 97,260 90,502 100,119 103,135 100,863 99,785 102,354

Steroid 2,835 2,829 2,969 3,118 3,312 3,279 3,523 2,841 3,635 3,744 4,091 4,268 4,441

Stimulant 57,611 59,052 60,717 62,350 65,936 67,644 70,232 59,331 76,563 80,612 81,619 82,966 89,755

Blank 155 140 147 172 201 208 207 140 68 167 210 72 212

Total 316,777 306,845 314,306 316,085 325,054 317,782 322,565 308,960 334,951 340,268 337,442 333,238 349,707

Presenter Notes
Presentation Notes
Explore > Appriss Provided [Interact Only] > PDMP Stats > Drugs by Class, County > Adjust timeline in the top right corner to reflect the correct quarter 
Blank is unassigned and Null added together

Last recording of GI narcotic was in March of 2021 (change of its classification?)



TOP 200 PRESCRIBERS BY NUMBER OF 
PRESCRIPTIONS 2023 QUARTER 4
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Presenter Notes
Presentation Notes
Explore > State Created folder > Top Prescribers – Converted > Top Prescribers > Adjust timeline to reflect the current quarter (in lower right hand corner > Hit Download in the upper right hand tab > Data > Download all rows as a text file > NABP interconnect page will pop up, do not sign in, click on excel sheet in the lower left hand corner > Delete all columns except for Measure Names and Measure Values > highlight both columns > Sort Data, sort by A to Z for Measure Names column > Delete data from cells measuring Quantity, want to keep only the cells that count the Prescription Count > Highlight Measure Values column > Sort Data, largest to smallest > Transfer top 200 to the graph in the PowerPoint




Reportable Prescriptions per Patient County 
Quarter 4 - 2023

Patient County 2023 Population Prescription 
Count

Prescription 
Count Per 

Population 
Quantity Quantity Count 

Per Population
Patient 
Count

Prescription 
Count Per 

Patient

AVG Quantity 
Per Patient

Grand Total 773,344 293,303 0.38 16,262,546 21.03 108,161 2.71 150.35
Adams 2,237 916 0.41 55,058 24.61 303 3.02 181.71
Barnes 10,869 5,550 0.51 310,673 28.58 1789 3.10 173.66
Benson 6,090 2,574 0.42 128,540 21.11 835 3.08 153.94
Billings 839 145 0.17 6,703 7.99 61 2.38 109.89

Bottineau 6,442 2,262 0.35 115,702 17.96 897 2.52 128.99
Bowman 3,024 908 0.30 49,247 16.29 355 2.56 138.72

Burke 2,177 793 0.36 50,701 23.29 315 2.52 160.95
Burleigh 97,895 36,741 0.38 2,049,678 20.94 13703 2.68 149.58

Cass 182,992 70,114 0.38 3,678,667 20.10 26015 2.70 141.41
Cavalier 3,725 1,466 0.39 80,276 21.55 573 2.56 140.10

Dickey 5,013 2,029 0.40 121,132 24.16 687 2.95 176.32
Divide 2,196 647 0.29 47,329 21.55 239 2.71 198.03
Dunn 4,054 1,356 0.33 74,927 18.48 488 2.78 153.54
Eddy 2,378 1,002 0.42 60,807 25.57 341 2.94 178.32

Emmons 3,316 897 0.27 49,629 14.97 365 2.46 135.97
Foster 3,396 1,337 0.39 79,238 23.33 489 2.73 162.04

Golden Valley 1,812 694 0.38 39,871 22.00 264 2.63 151.03

Presenter Notes
Presentation Notes
This report comes from Appriss:
Explore > State Created [Editable] > PatientCounty_DrugTrend > Patient County Analysis > select the time frame (months in Q1, 2, 3, or 4) you are looking for (Filled At section) & Uncheck the already selected timeframe > This report will be for all therapeutic classes so leave (All) checked under AHFS Therapeutic Class > Download (at the top), Data, click on download all rows…, open the file, sort by Measure Names, manipulate the data so that the County, Measure Names, and values are all that’s left for data.
Patient County, Prescriptions Count, Quantity 
Copy and paste the prescription count into the prescription count boxes for the next 3 slides, & the same for the Quantity (remove decimals first) and then format it to match the other font using format painter.
Don’t forget to calculate the total & averages on the bottom/3rd slide
FORMAT: Title Row Alignment: Horizontal & Vertical – Center, Font Size 14, Calibri
                 “Prescription per Person”, Format Cells>Number>Decimal places: 3, Alignment>Horizontal Right Indent: 2 & Vertical Center, Highlight cells>Conditional Formatting>Color Scales>Red-Yellow-Green Color Scale, Bold Total/Average Row
                “Units(quantity) per Person”, Format Cells>Number>Decimal places: 2, Alignment>Horizontal Right Indent: 2 & Vertical Center, Highlight cells>Conditional Formatting>Color Scales>Red-Yellow-Green Color Scale, Bold Total/Average Row
(Done in Excel)




*https://www.northdakota-demographics.com/counties_by_population has all the ND counties by population and rank (double check year)
*Take out McPherson county because it’s not actually a ND county (there are 53 counties)
*”Quantity” on the Appriss report is the same thing as Total Dosage Units on the spreadsheet
*Use the SUM and AVERAGE functions on Excel to calculate Prescription Per Person (Prescription Count/Population) and Units Per Person (Total Dosage Units/Population) and also for the Totals row at the bottom of the table
*For the color coating: Highlight row > Conditional Formatting > Color Scales > Top row 2nd one in (the green should be the lowest numbers and gradually going to red for the highest numbers)
* For the Population through Units Per Person right indent formatting: highlight content in excel >  right click > select format cells > choose Alignment tab > under Horizontal: select Right (Indent) > and in the Indent: box select 1 > click OK



Reportable Prescriptions per Patient County 
Quarter 4 - 2023

Patient County 2023 Population Prescription 
Count

Prescription 
Count Per 

Population 
Quantity Quantity Count 

Per Population
Patient 
Count

Prescription 
Count Per 

Patient

AVG Quantity 
Per Patient

Grand Total 773,344 293,303 0.38 16,262,546 21.03 108,161 2.71 150.35
Grand Forks 73,101 27,395 0.37 1,489,188 20.37 9649 2.84 154.34

Grant 2,351 943 0.40 57,846 24.60 333 2.83 173.71
Griggs 2,242 884 0.39 47,140 21.03 338 2.62 139.47

Hettinger 2,502 946 0.38 61,477 24.57 326 2.90 188.58
Kidder 2,397 786 0.33 47,616 19.86 288 2.73 165.33

LaMoure 4,173 1,242 0.30 73,873 17.70 523 2.37 141.25
Logan 1,814 588 0.32 39,126 21.57 233 2.52 167.92

McHenry 5,420 2,141 0.40 128,849 23.77 845 2.53 152.48
McIntosh 2,568 975 0.38 57,167 22.26 353 2.76 161.95
McKenzie 13,762 3,889 0.28 209,017 15.19 1485 2.62 140.75

McLean 9,788 3,985 0.41 249,038 25.44 1540 2.59 161.71
Mercer 8,405 2,768 0.33 167,062 19.88 1080 2.56 154.69
Morton 32,916 13,258 0.40 807,434 24.53 4887 2.71 165.22

Mountrail 9,717 3,628 0.37 205,340 21.13 1302 2.79 157.71
Nelson 3,035 1,573 0.52 82,049 27.03 547 2.88 150.00
Oliver 1,850 395 0.21 25,120 13.58 146 2.71 172.05

Pembina 6,912 2,709 0.39 167,527 24.24 1052 2.58 159.25
Pierce 4,038 1,551 0.38 85,961 21.29 546 2.84 157.44



Reportable Prescriptions per Patient County 
Quarter 4 - 2023

Patient County 2023 Population Prescription 
Count

Prescription 
Count Per 

Population 
Quantity Quantity Count 

Per Population
Patient 
Count

Prescription 
Count Per 

Patient

AVG Quantity 
Per Patient

Grand Total 773,344 293,303 0.38 16,262,546 21.03 108,161 2.71 150.35
Ramsey 11,638 5,651 0.49 310,217 26.66 1826 3.09 169.89
Ransom 5,679 2,580 0.45 135,577 23.87 898 2.87 150.98
Renville 2,328 803 0.34 45,027 19.34 340 2.36 132.43

Richland 16,546 6,244 0.38 342,589 20.71 2464 2.53 139.04
Rolette 12,508 5,642 0.45 303,850 24.29 1876 3.01 161.97

Sargent 3,839 1,228 0.32 77,251 20.12 527 2.33 146.59
Sheridan 1,328 521 0.39 31,581 23.78 226 2.31 139.74

Sioux 3,993 1,067 0.27 63,179 15.82 364 2.93 173.57
Slope 775 109 0.14 8,348 10.77 36 3.03 231.89
Stark 32,710 13,665 0.42 768,010 23.48 4932 2.77 155.72

Steele 1,870 510 0.27 33,020 17.66 221 2.31 149.41
Stutsman 21,678 9,568 0.44 533,009 24.59 3345 2.86 159.34

Towner 2,190 887 0.41 58,090 26.52 309 2.87 187.99
Traill 8,008 3,027 0.38 187,617 23.43 1238 2.45 151.55

Walsh 10,631 4,766 0.45 268,216 25.23 1659 2.87 161.67
Ward 69,686 22,257 0.32 1,224,827 17.58 8851 2.51 138.38
Wells 4,031 1,900 0.47 111,811 27.74 683 2.78 163.71

Williams 38,460 13,791 0.36 761,319 19.80 5174 2.67 147.14



Opioid Prescriptions per ND Patient County 
Quarter 4 - 2023

Current Patient 
County

2023 
Population

Prescription 
Count

Prescription Count Per 
Population Quantity Quantity Per 

Population
Patient 
Count

Prescription Count Per 
Population

Quantity Per 
Population

Grand Total 773,344 84,714 0.11 4,106,857 5.31 39,725 2.13 103.38
ADAMS 2,237 348 0.16 23,005 10.28 148 2.35 155.44
BARNES 10,869 1,576 0.14 75,376 6.93 676 2.33 111.50
BENSON 6,090 1,212 0.20 50,716 8.33 457 2.65 110.98
BILLINGS 839 43 0.05 1,626 1.94 24 1.79 67.75

BOTTINEAU 6,442 749 0.12 28,363 4.40 386 1.94 73.48
BOWMAN 3,024 313 0.10 16,020 5.30 160 1.96 100.13

BURKE 2,177 291 0.13 15,381 7.07 135 2.16 113.93
BURLEIGH 97,895 11,221 0.11 562,064 5.74 5,197 2.16 108.15

CASS 182,992 15,885 0.09 624,406 3.41 7,790 2.04 80.15
CAVALIER 3,725 455 0.12 20,145 5.41 228 2.00 88.36

DICKEY 5,013 657 0.13 35,495 7.08 277 2.37 128.14
DIVIDE 2,196 241 0.11 17,405 7.93 106 2.27 164.20
DUNN 4,054 526 0.13 29,400 7.25 226 2.33 130.09
EDDY 2,378 343 0.14 19,666 8.27 159 2.16 123.69

EMMONS 3,316 350 0.11 14,989 4.52 165 2.12 90.84
FOSTER 3,396 445 0.13 24,528 7.22 202 2.20 121.43

GOLDEN VALLEY 1,812 227 0.13 13,503 7.45 117 1.94 115.41

Presenter Notes
Presentation Notes
Take Population and Population Rank from previous slides
Explore > State Created [Editable] > Kathys_Workbook > MME, Rx Count, & Qty by Patient County > Adjust time line for current quarter in the upper right hand corner > Download > Data > Download all rows as a text file > NABP interconnect page will pop up, do not sign in, click on excel sheet in the lower left hand corner > Highlight all columns and Sort Data by Total MME, smallest to largest > delete the cell data with 0 total MME > Highlight all columns, Sort Data and sort by Patient County A to Z
Copying and paste each county’s cell data into a new sheet (Keep title row if needed) > Highlight Patient Key column, Remove Duplicates (under Data tab), Continue with current section

Prescription Count  SUM of Prescription Count column
Prescription Per Person  Divide Prescription Count by Population
Total Dosage Units  SUM of Quantity column
Unit Per Person  Divide Total Dosage Units by Population
MME Patient Count  Last cell number under Patient Key column (minus 1 for title cell if used), this is why we removed the duplicates previously
Total MME  SUM of Total MME column 
MME Per Patient  Divide Total MME by MME Patient Count





*https://www.northdakota-demographics.com/counties_by_population has all the ND counties by population and rank (double check year)
*”Quantity” on the Appriss report is the same thing as Total Dosage Units on the spreadsheet
*Use the SUM and AVERAGE functions on Excel to calculate Prescription Per Person (Prescription Count/Population) and Units Per Person (Total Dosage Units/Population) and also for the Totals row at the bottom of the table
*For the color coating: Highlight column > Conditional Formatting > Color Scales > Top row 2nd one in (the green should be the lowest numbers and gradually going to red for the highest numbers)
* For the Population through Units Per Person right indent formatting: highlight content in excel >  right click > select format cells > choose Alignment tab > under Horizontal: select Right (Indent) > and in the Indent: box select 1 > click OK



Opioid Prescriptions per ND Patient County 
Quarter 4 - 2023

Current Patient 
County

2023 
Population

Prescription 
Count

Prescription Count Per 
Population Quantity Quantity Per 

Population
Patient 
Count

Prescription Count Per 
Population

Quantity Per 
Population

Grand Total 773,344 84,714 0.11 4,106,857 5.31 39,725 2.13 103.38
GRAND FORKS 73,101 7,798 0.11 373,184 5.11 3,607 2.16 103.46

GRANT 2,351 392 0.17 22,760 9.68 173 2.27 131.56
GRIGGS 2,242 249 0.11 9,090 4.05 130 1.92 69.92

HETTINGER 2,502 350 0.14 20,917 8.36 159 2.20 131.55
KIDDER 2,397 285 0.12 15,833 6.61 127 2.24 124.67

LAMOURE 4,173 394 0.09 15,522 3.72 199 1.98 78.00
LOGAN 1,814 184 0.10 9,491 5.23 96 1.92 98.86

MCHENRY 5,420 675 0.12 33,775 6.23 332 2.03 101.73
MCINTOSH 2,568 402 0.16 17,918 6.98 171 2.35 104.78
MCKENZIE 13,762 1,157 0.08 54,766 3.98 564 2.05 97.10

MCLEAN 9,788 1,473 0.15 82,173 8.40 682 2.16 120.49
MERCER 8,405 1,038 0.12 60,647 7.22 465 2.23 130.42

MORTON 32,916 4,276 0.13 245,633 7.46 1,965 2.18 125.00
MOUNTRAIL 9,717 1,181 0.12 65,333 6.72 533 2.22 122.58

NELSON 3,035 490 0.16 24,453 8.06 223 2.20 109.66
OLIVER 1,850 152 0.08 9,559 5.17 65 2.34 147.06

PEMBINA 6,912 833 0.12 44,122 6.38 406 2.05 108.67
PIERCE 4,038 511 0.13 21,111 5.23 243 2.10 86.87



Opioid Prescriptions per ND Patient County 
Quarter 4 - 2023

Current Patient 
County

2023 
Population

Prescription 
Count

Prescription Count Per 
Population Quantity Quantity Per 

Population
Patient 
Count

Prescription Count Per 
Population

Quantity Per 
Population

Grand Total 773,344 84,714 0.11 4,106,857 5.31 39,725 2.13 103.38
RAMSEY 11,638 2,001 0.17 99,164 8.52 776 2.58 127.79

RANSOM 5,679 652 0.11 26,181 4.61 312 2.09 83.91
RENVILLE 2,328 189 0.08 9,415 4.04 102 1.85 92.30

RICHLAND 16,546 1,547 0.09 63,348 3.83 801 1.93 79.09
ROLETTE 12,508 1,915 0.15 110,693 8.85 851 2.25 130.07

SARGENT 3,839 353 0.09 15,584 4.06 183 1.93 85.16
SHERIDAN 1,328 210 0.16 11,245 8.47 109 1.93 103.17

SIOUX 3,993 497 0.12 27,404 6.86 200 2.49 137.02
SLOPE 775 43 0.06 4,378 5.65 20 2.15 218.90
STARK 32,710 4,776 0.15 248,736 7.60 2,060 2.32 120.75

STEELE 1,870 153 0.08 6,550 3.50 84 1.82 77.98
STUTSMAN 21,678 2,713 0.13 128,390 5.92 1,248 2.17 102.88

TOWNER 2,190 335 0.15 22,505 10.28 140 2.39 160.75
TRAILL 8,008 678 0.08 29,039 3.63 382 1.77 76.02
WALSH 10,631 1,444 0.14 74,196 6.98 651 2.22 113.97
WARD 69,686 5,600 0.08 262,894 3.77 2,896 1.93 90.78
WELLS 4,031 607 0.15 32,838 8.15 265 2.29 123.92

WILLIAMS 38,460 4,279 0.11 235,924 6.13 2,052 2.09 114.97



PMP InterConnect and PMP Gateway are tools 
being used by PDMPs across the US to combat 
drug diversion and drug abuse nationwide.

PMP InterConnect, the only national network of 
Prescription Drug Monitoring Programs 
(PDMPs), is a secure data-sharing hub that 
breaks down siloes and enables the sharing of 
PDMP data across state lines, providing 
clinicians and pharmacists with a more complete 
patient history upon which to make decisions. 
This capability is critical for physicians and 
pharmacists to more easily identify patients who 
may be obtaining prescription medications for 
any purpose other than the treatment of an 
existing medical condition, including for purposes 
of abuse, misuse or diversion, especially if those 
patients are crossing state lines to obtain drugs. 
PMP InterConnect, as of June 2022, connects 53 
of the 54 PDMPs in the US, facilitating more than 
949 million responses every month. PMP 
InterConnect was developed in 2011 at the 
request and direction of the National Association 
of Boards of Pharmacy (NABP) and a group of 
state PDMP directors. It is governed by its 52 
PDMP members.

Find more information at https://pdmpworks.org

PMP InterConnect



Gateway Facilities

PMP Gateway integrates PDMP data, 
analytics, insights and resources into 
electronic health records, health 
information exchanges, and 
pharmacy management system 
workflows, making it easy and 
efficient for healthcare providers and 
pharmacists to access patient 
information, in line with state 
laws, before prescribing/dispensing 
additional medication. More than 
1.14M prescribers and pharmacists at 
over 158,000 facilities in 43 States 
are using PMP Gateway service in 
110 million patient encounters per 
month.
For ND there were 594 Active 
Gateway facilities in the Last 18 
months. (most recent data June 2022)

Find more facts at https://pdmpworks.org



PDMP Interstate Sharing Hub, PMP Interconnect
- 1.08 billion transactions per month
- Supports 53 of 54 U.S. PDMPs
- The Military Health System elects to participate (2020)
- 247% increase in usage year after year
- PMP InterConnect is provided at NO cost to the PDMPs by NABP
- Interstate data requests over InterConnect are usually returned in 
under two seconds

PDMP Clinical Workflow Integration, Gateway
- 1 in 3 prescribers use PMP Gateway integration
- 179% increase in usage year after year
- Over 107 million transactions are completed each month, March 2022
- Integrations are complete with over 130 electronic health records and 
every major pharmacy system vendor, making implementation quick 
for interested health systems and pharmacies.

This & more data available at pdmpworks.org

Gateway

Presenter Notes
Presentation Notes
No changes to this yet on the website

Visit site on the slide to view the map > open snipping tool (click on the magnifying glass icon in the search bar below and type in “snipping tool”) > Select New > Copy area to snip > File > Save As > Kathy > Bamboo > Reports > Quarterly > Name as “2021 Q3 PMPI map connections”

Map Colors:
EDAD08 Orange=Not Connected
9CCB86 Green=Connected
D9D9D9 Grey=Do Not Utilize PMPi Hubedad08




ND’s PMPi  Hub Connection Status

Military Health

Presenter Notes
Presentation Notes
No changes on the pmpi connections

To Create Map:
https:// mapchart.net/usa.html

Map save under Kathy > Bamboo > Reports > Quarterly > mapchartSave_usa_(1).txt
Word doc is saved as map.docx
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